" Scanning has never before
been this easy. You need no

previous experience to use the

intelligent ScanWise interface

DO it ScanWise! for your Agfa scanner.
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fresneeennenine e To find how to make perfect scans for a

wide range of applications, open a tab menu.

Click the numbered light bulbs at the side of

the descriptions to view useful tips.

Having read the relevant tips, you can return
to the same point in the description by

clicking this icon in the upper left corner.
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If you have a color or black and white
printer configured on your computer,
ScanWise will find it. You can then make
copies of photos, or any other types of
original images, by scanning them
directly to the printer.
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How it works
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Imagine you're the marketing manager for a
manufacturer of handbags and you want to copy the
latest proposals from your advertising agency to
distribute among colleagues.

You have an HP 720c color inkjet printer, which is
loaded with photo-quality AgfaJet glossy paper.

You place the original on the scanner bed and then
launch ScanWise. At the end of the automatic
Preview scan, the AutoSelect feature has located your
original and selected its borders. ScanWise even
detects the type of your original: it senses image- or
text-based documents.

When your original is selected, you then make
some very simple choices from the four tab
menus. Normally you start with the top tab and
progress down to the SCAN button.

AGFA <
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The first tab opens the Original Type menu. Your
original is a contract proof made from the screened
films that will be used for printing. You select the
“Print (other)” option so that ScanWise will remove
the dots from the proof to improve the inkjet print
quality (descreening).

The second Destination tab menu displays the list of
compatible programs and printers available on your
system. ScanWise finds these items when it launches.
Here you click the printer option.

Image Control is the third tab, which allows you to
define the appearance of your final scan. Color mode
has already been selected by ScanWise but there are
two ways to fine-tune your results. You can manually
adjust the brightness, contrast and saturation with
the sliders, but if the quality of the original is poor, tr
Photogenie for a beter result.
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You use the last tab menu, Dimensions, to set the size
of the printed image. This is either indicated as a
percentage of the original size, or you enter its
dimensions.

After these four simple settings have been made, you
can hit the SCAN button.The normal printer dialog
then opens, allowing you to alter settings if necessary.
And that’s all you have to do: ScanWise now makes
the final scan and feeds it directly to your printer.

They'll be crazy about these simulated Frisian Cow
handbags - they're definitely worth putting money
into!
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Share it ScanWise!

o M- 8RRl R R B el R el B s e R R

Fax Type File ' Design ' Publish

Suppose you have some photos, slides,
negatives or drawings that you would
like to send to a colleague by e-mail.
These could be urgent work-related
items or simply your latest holiday
snaps. ScanWise automatically scans
your originals and places them directly
into your favorite

e-mail application: it’s as easy as
typing the e-mail itself!
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Let’s say you want to send some snaps of your latest
ascent of Everest to your Granny in Wichita by e-mail.
Well who knows?

You place your photos on the scanner bed and then
click the Preview button. ScanWise finds the photos
and selects their borders. Assuming you were
wearing some trendy climbing gear, it will also detect
the fact that they are colored originals!

Now you choose one option from each of the four
tab menus. Starting with the top Original Type menu,
you descend swiftly towards the SCAN button.

You pick “Photo - glossy” from the Original Type tab
menu and then move on to the Destination tab
menul. |
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.6} This Destination menu displays the list of compatible
programs and printers available on your system.

ScanWise finds these as it launches. You click the
“Mail recipient” as your destination.

.83 .93 10} 11} In the third Image Control tab you find that Color
mode has already been selected by ScanWise. You
can manually adjust the brightness, contrast and

saturation with the sliders, but if the quality of the
original is poor, try Photogenie fot a better result.

"2? x@ So that Granny won't have to waste on-line time, you
set the image size to 50% in the last Dimensions
menu. The default resolution setting for e-mail

images intended for on-screen viewing is lower
than printed images.
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You repeat these four simple settings for each
original, and then hit the SCAN button. ScanWise
now makes the final scans, opens your e-mail
application, creates a new mail and then pastes in the
images as attachments. All you need to add is
Granny’s e-mail address and wish her a very happy
90th birthday. Even free fall couldn’t be simpler!
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When you have software on your
computer to send faxes via your modem,
ScanWise will locate this. You can then
immediately fax hard-copy documents,
images or drawings just like a
conventional fax machine. .
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Imagine it’s your seventh birthday! You've put a lot of
effort into creating your own party invitation but it's
too late to post it to your friends. Some of them don't
have an e-mail connection but their parents do own
fax machines.

Calmly put your card on the scanner bed. Open
ScanWise and click the Preview button. Your card
appears with a border surrounding it. But there’s also
a red outline that you definitely didn’t draw. Don't
panic:it’s only clever ScanWise showing you that it
will use AutoRotate to straighten up your card so that
it will fax perfectly. You obviously weren’t calm
enough!




Fax Type File ' Design ' Publish
11

2D 3 4 Opening the first Original Type menu, you click the
Original artwork option.

.63 In the next tab menu called Destination, you select
the fax option.

.73 .83 .9} Then in the third Image Control menu you select the
Grayscale mode and you see that ScanWise has done

a great job in adjusting the tonal ranges, preserving
all your artistic details! You don't bother altering the
other sliders.
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Since you want to send your invitation at full size,

there’s no need to go into the Dimensions menu
because this will be already set to 100%.

So all you have to do is click the SCAN button.

The normal dialog box of your fax application opens
to allow you to give the fax number and that’s it.
Get into your party gear!
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If you've installed the optical character
recognition program (OCR) that was
supplied with your scanner, ScanWise
can easily save you hours of re-typing
printed matter. Documents are scanned,
converted to text and then automatically
loaded into your favorite word
processor.
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How it works
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You're a head chef for the duration of this example,
if not for life! It's time to revitalize the image of your
restaurant so you've decided to whip up a new,
dynamic menu.The old menu was typed out
manually so you don't have digital text files.

Rather than wasting valuable time re-typing it,

you use ScanWise to do the job in seconds.

Having fed your old menu into the scanner, you click
the Preview button in ScanWise.

The menu is automatically selected in the Preview
window and is outlined in red.This tells you that
in your haste you laid the menu on an angle.

If you scan lines of text on an angle, your OCR
program may have problems recognizing the
characters. For error-free results, ScanWise uses

AGFA <
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its built-in AutoRotate function to square up the text.

You can also rotate the selection manually by
dragging the corner handles.

Icons on the preview indicate the settings detected
by ScanWise. One of these shows that your menu has
been recognized as text, so you don’t need to open
the first Original Type menu.

In the second Destination tab menu, you choose your
word processor.

The combination of a text Original Type and the word
processor Destination tells ScanWise that OCR must
be used, resulting in the Image Control and
Dimensions tab menus being disabled.

So that couldn’t have been much simpler: all
you had to do was open a single menu!

AGFA <
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ScanWise gets cooking, converting your old menu to

Line Art, passing this image into your OCR program,

then opening your word processor and pasting in the

converted text. You can immediately add your latest

mouth-watering creations, before sending the file to

a design bureau.

Don’t you wish you had such reliable, fast-moving,
self-motivated staff?!

V£ ok ]
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Suppose you have a number of originals
to scan for later use in various
applications, ScanWise automatically
saves these in the format and location
of your choice.
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E-mail

How it works

o M-8R Rl R B e R el B s e R R

Fax Type File  Design Publish
1

Having just returned from a Mayan architecture
pilgrimage, you've got one more week of summer
holiday to prepare your history courses for the

new academic year. You bravely carried back an
over-loaded back-pack full of photos, post cards,
brochures, tickets and other items.

These will undoubtedly form a wonderful record of
Chichén Itza and other Mayan sites but you still have
to scan them all!

ScanWise is the perfect tool for the job, automating
virtually the whole scanning process. Since you're
not sure at this stage how you are going to use all
the images, you've decided to scan and save

them as RGB TIFF files.

The quickest way to scan a large number of
varied originals is to first sort them into sets of

AGFA <
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similar types. So you fill the scanner bed, leaving a

small space between each original. Then launch
ScanWise and click the Preview button.

The fact that all originals on the scanner bed are of
the same type means you can now choose default
settings that will be applied to them all.

In the first tab menu called Original Type, you select
the correct option for the group of originals now on
the scanner bed.

In the second Destination menu you right-click the
“File” option on a PC and select “Properties” from the
menu that opens. On a Macintosh you double-click
the option. This opens a dialog where you

indicate the folder that files will be saved into

by clicking the “Choose...” button. You pick TIFF ,
from the “File type” drop-down menu, activate

the “Embed color profiles” checkbox to include

AGFA <
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ICC profiles in your files. Then you indicate the
default image resolution, make sure the “Ask filename
before each scan” checkbox is not ticked, and finally
click OK to save these settings as defaults. ICC profiles
ensure that the color in your scans will be correctly
interpreted on any Macintosh or Windows PC.
The File option is now selected.

ScanWise intelligently sets the color mode for you,
but there is nothing to stop you scanning colored
originals in Grayscale or Line Art mode. Just use the
scan mode settings in the Image Control menu.

You don’t need to open the Dimensions menu
because the default scale is 100%.

Now that all of the defaults are set, you click

the Preview button again. All originals are [
automatically assigned these settings except for

the settings made in the Image Control menu.

AGFA <
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This working method avoids having to activate each
original in turn to set its options.When you click the
SCAN button, all originals are scanned sequentially
and are saved in the location and format you
specified.

Now you can sit back and remember those mystical
dawns in Chichén Itz3, before the onslaught of the
new academic year!
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Design it ScanWise! while you are working in an image
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editing application, such as Adobe
Photoshop, ScanWise is directly
accessible, allowing you to scan new
source material without leaving the
application. |
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Today you're a textile designer, working on a new
range of summer dress fabrics. Working in Photoshop
to experiment with different colorways, you decide
that your overall design is too flat. To introduce some
texture you decide to scan a piece of coarse, hand-
made paper.

Without leaving Photoshop, after placing the paper
on your scanner bed you select the ScanWise driver
from the File menu.This directly opens the ScanWise
interface and an automatic Preview begins.

After the Preview scan is complete, the whole piece of
paper is now selected but you spot a couple of
areas that contain some really chunky
vegetation: looks like someone threw a palm
tree in there!
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Since you don’t want the full, automatic selection
made by ScanWise, you click the Remove Selection
button at the top-right of the interface to delete it.

After clicking the “New Selection” tool at the top of
the interface, you now draw two selection rectangles
around the details that interest you.These overlap
but that’s no problem.You adjust their sizes with the
corner handles and shift their positions by dragging
anywhere inside the selection rectangles.

Now you need to set up the scanning options for
each selection. In the Original Type tab menu, you
pick the “Original artwork” option.

The Destination tab menu only shows the
Photoshop option, so go on to the Image

Control menu. ScanWise opted for Color, but in ,
this case you want to create Grayscale images

that you can use as layer masks in Photoshop.

AGFA <
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You click the Grayscale button and make sure that
PhotoGenie is switched on.

15} Moving to the Dimensions tab menu, you enter the
‘? width of your repeat pattern.You see that the default
image resolution is too low, so clicking the arrow to
the right of this information opens a menu where you
type in the new resolution for this scan.

the SCAN button. Two new Photoshop documents
are opened, containing your textures. All you have to
| do is copy and paste these into layer masks and you
& i can then make color corrections through them to
introduce your chunky texture!

? Having set the options for both selections, you click

g

The possibilities are endless. Scan real leaves as
Line Art, pressed flowers in full Color: whatever [
you need, just scan it in.
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Fax Type
So now it's time to turn up that Havanan bolero and
drift off to sunny palm beaches: this design is going

to be a winner!
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With a word processor on your system,
such as Microsoft Word, you can scan
images directly into documents without
intermediate processing. Add an OCR
application to the work flow and
ScanWise even scans editable text
straight into your pages.
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How it works You just stepped into the shoes of a graphic designer
who is working on a documentary book of graffiti
and artwork produced in Berlin before the Wall came
down.You've made a mock-up of the front cover and
you have the layout worked out. In order to convince
your publisher to print the book, you want to make
up a Word document containing some images to
illustrate your text.

You've put the front cover design on your scanner
bed and have launched ScanWise. After the
automatic Preview has finished, the cover is
displayed with its borders selected.

.2 24} Now you set up the scanning options by leafing
through the four tab menus. In the first Original

Type menu, you select “Original artwork” Then
you move to the second Destination menu and
4 pick your word processor.
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Image Control is the next menu. Here you find that
ScanWise has already selected Color mode for you,
using its AutoDetect function. So there’s nothing to
do in this menu: you're beginning to feel a little
redundant!

At least your input is needed in the last Dimensions
menu. Intended for the European market, the book
will have an A4 format, so you enter a height of

303 mm to allow for bleed. ScanWise automatically
calculates the scaling factor for you.

When you hit the SCAN button, ScanWise captures
your design and simultaneously enhances it.

The word processor you chose is now
automatically opened by ScanWise, a new
document is created and the image is pasted

into it. Following the same procedure you scan
your other images and then add the text. Within
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minutes you have produced a very acceptable
sample of your proposed layout.

With such a good result, you're certain that your
publisher will break down any barriers preventing
you going to press!
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We have built optimal default settings
into ScanWise to allow you to scan
originals and to place them directly into
the application of your choice with only
a single click of the SCAN button.

To streamline your scanning, check the
following interface settings (it may be
One-click scanning useful to print this page as a guide).

MU E R [
= e Hddddddd s

OME-CLfokeiT
7 |




fod 8CE R R A R R B d RN el d BCEEE R

1. Select“Options...” from the Tools menu on
a PC or “Preferences...” on a Macintosh.

2. In the Intelligence tab menu, turn on the
“Find multiple originals” option in the
“AutoSelect” section.

3. Make sure the “AutoPreview at startup”
checkbox is ticked (on).

4. In the Preview tab menu, turn on the “Always”
option in the “Display setting icons” section
and click OK to confirm these changes.

5. Open the Original Type tab menu. Drag the
option that describes the originals you are most
likely to be scanning to the top of the list.
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. Open the Destination tab menu, right-click the

. When the defaults have been set, drag this

option to which you want to scan and select
“Properties” from the menu that opens (double-
click the option on a Macintosh). A dialog now
opens, which allows you to change the default
settings as required. When scanning to a file, for
example, the following default settings can be
specified: the image resolution; the folder in
which the file should be saved; the file format;
whether to include ICC profiles or not; whether
filenames for each scan will be requested or
automatically created.

destination to the top of the list. AutoSelect
uses the first option in the list as its default
destination, when ScanWise is first

launched. .
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How it works

You place your original image(s) on the scanner
bed and then launch ScanWise.

A preview is made automatically, which selects
your original(s). The first icon displayed on each
selection in the Preview window shows the
Original Type(s) that ScanWise will use.

The Destination is set to the first option in the
list, as indicated by the second icon on each
selection.

A third icon indicates the detected color mode.
PhotoGenie optimization is on by default so
there is no need to open the Image Control
menu.

The output size will be 100% by default so if
this is acceptable, you don't need to open
the Dimensions menu. .

You only need one click: the SCAN button!
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Tip 1 - Icons showing the Original Type,

Destination and Color Mode for each original
can be displayed in the Preview window.

To set the options for this display mode, open
the Tools menu and click “Options...” on a PC,

or “Preferences...” on a Macintosh.

Then select the “Preview” tab.

@.
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Tip 2 - If your scanner supports the transparency

option, you have to select Transparency Preview
or Reflective Preview by clicking the button next
to the Preview button.The automatic Preview
scan that activates when ScanWise launches can
be turned on or off by changing the preference
settings in ScanWise. If the automatic Preview
scan is turned on and your scanner supports the

transparency option, a preview is made in the

previously selected preview mode
(Transparency or Reflective Preview). @
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Tip 3 - If your original is not squarely placed
on the scanner bed, ScanWise draws a red
outline around it to indicate that the
AutoRotate feature will correct this during
scanning. You can also rotate the image
manually by dragging the corner handles of
the selection.You can even rotate the
image over predefined angles (90° clock-
wise, 90° counterclockwise, 180°, etc.) if

you placed the original in the wrong

direction. Press the F button in the

Dimensions menu to do this.

@.



0 Tip 4 - The Guide Me mode is both started
e and stopped by the button at the top-left of

the interface. This mode guides you
through all tab menus and explains their

functions.

@.
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Tip 5 - If you put more than one original on
the scanner bed, ScanWise will make
multiple selections. The tab menu settings
for each selection are then chosen
individually. Every selection can have
different settings. If the destination can only
handle a limited number of selections at a
time, you have to choose the selections you

want to scan.

@.
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Tip 6 - If the ScanWise AutoSelect function
finds a text-based document, it automatically
sets the Original Type to “Text” Otherwise it
uses the first option in the Original Type list
when ScanWise is first launched. If you select
a different type, this becomes the automatic

default for any non-text documents that are

selected during the current ScanWise session.

Drag your most commonly used Original
Type to the top of the list to avoid the

manual setting of this tab menu in most

cases.

@.
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Tip 7 - Microsoft Windows users will find
that the Destination tab menu contains a
list of all currently defined printers and fax
applications. On the Macintosh platform,
the current setting of the Chooser in the
Apple menu will determine which printer or
fax will be the target of the “Printer/Fax”
destination. If necessary, change the

Chooser setting before making your scan.

@.
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Tip 8 - Drag commonly-used options to the
top of the Destination list for rapid access.
The first option will always be the default
setting when ScanWise is launched, so make
this your most frequently used destination.
This will save you having to open the
Destination tab menu for most scans.

When you pick a different destination,

this becomes the default setting for both

manual and automatic selections while

you remain in ScanWise.

©
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Tip 9 - To view or change the default

output settings of a specific option in the
Destination list, right-click the option on a
PC and select “Properties” from the menu
that opens, or double-click the option on

a Macintosh.
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a Tip 10 - Generally speaking, the “Mail
= recipient” destination will be your normal

e-mail application. The default Mail
recipient on Windows platforms is the last
MAPI-compliant e-mail application that has
been installed or configured. On Macintosh
platforms using operating systems below
8.5, the Mail recipient is determined by the
preference settings of the third-party

Internet Config utility. From system 8.5

onwards, the settings of the built-in @

Internet control panel are used.

-




Tip 11 - Many destinations require a scan to be
saved on your computer, including the “Mail
. recipient”and “Web image” options. The Agfa
' default location of these scans on a Windows
2 NT system is your “Personal” folder. On

Windows 95 and 98 systems they will be saved
in the “My Documents” folder. The default
location on a Macintosh will be in a“ScanWise
Images” folder on your Desktop. An alternative
location can be individually set for each
destination.To do this within Windows on a PC,
right-click the option in the Destination tab
menu and select “Properties” from the menu
that opens. On a Macintosh, double-click the
option. Clicking the “Choose..." button allows
you to browse through your folders to select
an alternative. In all cases except the “File”
destination, the names of the scans will be
“UntitledX’ where X is an incremental
number beginning from zero.

Z




Tip 12 - When scanning to the “File” destination,
the names of scans are either allocated
automatically or they are supplied by you.

This setting is changed on a PC by right-
clicking the option in the Destination tab menu
and selecting “Properties” from the menu that
opens. On a Macintosh, double-click the option.
If the “Ask filename before each scan” checkbox
is ticked, a Save dialog will be displayed for
every selected original before it is scanned.
This dialog also allows you to pick a default
filename and a different format from the
normal default setting. If the checkbox is

not ticked, the names of the scans will be
“UntitledX” or “NameX" if you selected a

default filename, where X is an incremental
number beginning from zero.
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Tip 13 - When icons are displayed on the
Preview selections, the current default
destination is indicated. If this is the
destination you want, there is no need to

open the Destination menu.
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Tip 14 - Double-click the slider controls to

reset them to the neutral position.
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a Tip 15 - PhotoGenie is highly intelligent,
e often improving the quality of poor

originals. When PhotoGenie is on, you don't
normally need to alter the correction
sliders. If the quality of the original is good

there’s no need to use PhotoGenie.

@.
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Tip 16 - Double-click the percentage slider

control to reset it to 100%.
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Tip 17 - When entering physical dimensions,
the units of measurement can be chosen
from the drop down lists at the side of the

numeric entry fields.

@.




resolution of the final scan is predefined. You
can change this default value on a PC by right-
clicking its entry in the Destination tab menu
and selecting “Properties” from the menu that
opens (double-click the option on a
Macintosh).The new value is used for all
following scans.To return to the Agfa default
image resolution, click the “Reset” button.

a Tip 18 - For most destinations, the optimum

In the Dimensions tab menu you can override
this default image resolution, for only the
actively selected original, by clicking the arrow
to the right of the Image Resolution
information. All other selections continue to
use the default settings that have been
separately defined for each option in the
Destination tab menu, as explained in the
previous paragraph.

©
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Tip 19 - If you want to put text and
diagrams directly into your word processor
as an image, rather than using OCR to
convert to editable text, select an option
other than Text in the Original Type menu.
Alternatively, scan to a file or an image
editor and add the image to your document

later.

@.




@ Tip 20 - If you make a Preview after having
g drawn manual selections, they will be

deleted.

@.
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Tip 21 - When you draw a selection
manually, its settings will be the same as
those you set for the previously active
image, or they will revert to default ones if
you have not chosen any settings during
the current session. For creating multiple
selections with the same settings, draw the
first, choose your settings for this and then

draw the other selections.

@.
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Tip 22 - Clicking on overlapping selections
activates the uppermost one. If you have
difficulty activating a certain selection
due to the overlapping order, use the
“Next selection” tool to loop through all

selections.

@.
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Tip 23 - When a selection is active, it has
resizing handles on all corners and sides and
rotation handles on all corners. Dragging a
handle on one of the sides changes the
position of that side only. Using a corner
handle changes the two adjoining sides
simultaneously. If you move the cursor around
the corners of the selection until it changes
into a rotation handle, you can rotate the
selection. If you place the cursor inside an

active selection, you can drag the whole

selection to a new position.

@.



@ Tip 24 - ScanWise can be launched directly

i from within certain applications, such as image

editors or word processors. The method and
availability depends upon both the type of
computer and its operating system. Within
image editors, the ScanWise option is normally
selected from the “Acquire” or “Import”
submenu in the “File” menu. The option might
be named “TWAIN_32" on PC platforms, or

“Agfa ScanWise” on Macintosh platforms.

be started via the “Insert” menu.

From other applications, ScanWise might @
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